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UPDATING FROM PREVIOUS VERSIONS OF DRAGSTRIP

If you have been using a previous version of DragStrip, it’s a good idea to back up your
previous strips before installing. Upon installing DragStrip and converting your 1.0, 2.0, or 3.x
strips to 4.0, your strips will look and work the same except they will have many new options.

The way in which DragStrip 4.0 stores files has changed since previous versions. DragStrip no
longer stores icons, aliases, etc. in the same manner. Therefore, existing strips from earlier
versions need to be converted to 4.0 strips. DragStrip 4.0 will automatically convert your
existing strips, as well as your preferences file and your document list. DragStrip renames

the old strips with an “old” suffix.

NOTE You cannot convert 4.0 strips back to earlier version strips.

SYSTEM REQUIREMENTS
Dragstrip will run on Mac OS 9.x and Mac OS X 10.1.x CarbonLib |.4 is required.

INSTALLING DRAGSTRIP

I) To install, copy the DragStrip installer from the CD-ROM to your hard drive, and restart
your Mac with extensions off. Installation problems can usually be avoided by installing
applications with minimal extensions loaded.

2) Locate and double-click the DragStrip installer icon.

3) When you are ready to proceed with the installation, click the “Continue” button; to quit,
click the “Cancel” button.

4) You must agree to the License Agreement before installing the software.
If you do not agree to the License Agreement you must quit the installation and remove
the software.When you click “Agree” the main installation window is displayed next.

5) Click the “Install” button for a full installation of all parts of the DragStrip package.

6) A dialog is presented asking where you would like to install DragStrip. Once you have
selected the destination, click the “Install” button.

7)  When the installation is complete you should see a dialog allowing you to “Continue” or
“Quit.” If you wish to install again, for example, onto another drive or partition, click
“Continue.”

8) When DragStrip first launches you will have the opportunity to enter your serial number.
If you choose to work in Demo mode it will be fully functional for 30 days.Thereafter you can-
not save any changes made to your strip. The strips will still be functional in every other sense.



GETTING STARTED

WHAT IS A STRIP?

00 My Strip
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Strips are composed of buttons, page tabs, and a title bar.

The buttons on a strip display aliases for items you wish to make launchable from strips. (An
alias is an icon you can use as a representation for a document, program folder, or disk, which
“points” to that item.) Also, buttons can hold data in the form of pictures, text, sound, URLs,
and QuickTime™ movies.

Page tabs let you switch between different pages of buttons.
The title bar allows you to name and move your strips around your desktop.

When you start up DragStrip for the first time, a wizard will launch that will help you config-
ure your strip. Please see Using the New Strip Assistant on page 3 for more information.

DRAGSTRIP PAGES

Strips can be broken down into multiple pages. Each page can have its own page color and can
contain as many items as the strip can hold. If you have run out of buttons then just extend
the strip either horizontally or vertically. Pages are a great way of organizing your strips based
on the projects you are working on or the applications you use frequently.

When page tabs are visible, you will see the page’s name in a tab along one edge of the strip.
Page tabs can be drawn along the top, bottom, left and right side of the strip, or they can be

hidden entirely. Even when page tabs are hidden, you can switch between pages by pressing
the option-tab key combination.

PLACING ALASES ON A STRIP

You can create an alias by dragging items from the Finder to a blank button on your strip.



When you open an alias, or click on a DragStrip button, the original item will open.

DragStrip can also be configured with a Processes page showing the currently running
processes on your Macintosh. This page is similar to the Applications menu in the upper right
hand corner of the Macintosh menu bar for the classic Mac OS. By clicking once on a process,
you will make it the front-most active application. If you are in one application and click on a
different application on the Processes strip, the application you clicked on will become active.

UsING THE NEw STRIP ASSISTANT

The New Strip Assistant walks you through several steps that allow you to create and config-
ure your new Strip. Any time you click on the New option in the File menu the New Strip
Assistant will launch.

) The New Strip Assistant first prompts you to enter a name for your new Strip. Type the
name in the text field, and then click the arrow at the bottom right of the window.

2) The next screen allows you to configure the appearance of the buttons on your new
Strip. Choose between small, large or huge icons, and tell DragStrip whether you want the
name of the item to appear on the button and/or as a tool tip. Make your selections and
click an arrow at the bottom right of the window.

3) The final option window allows you to add buttons for commonly-used applications, folders,
web pages, currently running processes, current drives and servers, documents, applications
and home to your new Strip. When you'’re finished, click an arrow at the bottom right of the
window. Pressing the “escape” key will quit the New Strip Assistant at any time.

SAVING YOUR STRIPS

Once a strip has been saved it will always be automatically saved. The name you gave the strip
in the New Strip Assistant is the name of the file it will be saved as.The only time you should
manually save is when you haven't named your strip in the New Strip Assistant (left the name
field blank) and you want to save it. In this case, DragStrip will ask you if you want to save

your strip when you try to quit or close the strip.

Note: If you have not entered a serial number and are in demo mode, after 30 days you will
not be able to make changes to your strip o save new strips.

You can save your strips manually by going to the File menu and choosing “Save” or “Save As.”
I) Highlight the File menu and choose “Save” or “Save As.”

2) Pick the location where you want to save the strip. It is a good idea to save your strips in
the Documents folder.

3) After picking the location, type in the name of your new strip and choose “Save.”



CLOSING A STRIP

Because DragStrip is an application, a strip is simply a document. In many word

processing programs, you can have multiple documents open at the same time and switch
between them; in this way, you can also have many open strips. If you close a strip and then
restart DragStrip, that strip will not appear on the screen until you open it. Only previously-
saved strips that you leave open will automatically appear on the screen when you restart
DragStrip, but your other strips will still be available, just like any other document. If you want
to close an open strip, you can do this in two different ways:

I) Choose Close under the File menu, or
2) Click on a strip’s close button in the upper left hand corner of the title bar of a strip.

Note: If no strips are set to re-open automatically when DragStrip starts, DragStrip will launch
the New Strip Assistant.

SEHECTING A STRIP

Switching between multiple strips can be accomplished by clicking anywhere on a strip. Since
an active strip may have its title bar hidden, it will also be marked as active by a darker shadow
on the bottom and left sides if you are running Mac OS X.

DeEnNG ItTems FROM A STRIP

Dragging a strip item to the trash will delete the item from your strip, but not from
your hard drive. Remember, items on strips are aliases of the real items. Therefore you are
not deleting the original file, only the reference to the file on that strip.

You can also shift-click multipile items, and then choose “Clear” from the Edit menu, or press
the Delete key to delete the selected strip items. “Clear” is not available for Window (Mac
OS 8.6-9.X) or Process items.

REARRANGING ITEMS ON A STRIP

You can move an existing item on a strip by clicking on the item and dragging it onto a blank
button on the strip itself, or you can drag to it to a blank button on another open strip.

In addition, if you option-drag an item from one location on a strip to a blank button on
another open strip, that will put a copy of that item on the new button.

You can also copy an item by shift-clicking on it, selecting the “Copy” command, clicking the
pointer on the button or strip you wish to move the item to, and choosing “Paste.* Cut and



Paste works in this manner as well. Copying items from one strip to another can also be very
useful in cleaning up strips, or placing frequently-used applications, files, or folders on many
different strips or different pages on the same strip. This does not apply to “Current Process”
and “Current Drives and Servers” page types.

You should make room for the new items you are copying or cutting (see below) before you
paste them. If you don’t have room for all the items on the strip you are moving them to,
DragStrip will only paste the items (consecutively) that it has room for on the strip. If you find
that all the items you wanted to paste onto the new strip aren’t there, resize the strip and
paste them again.

RESIZING A STRIP

You can resize a strip by dragging on the grow box or area in the bottom right hand corner of
the strip. Strips can resize horizontally or vertically by rows or columns.

To resize a strip:
I) Select the strip you want to resize by clicking on its title bar.

2) While clicking and holding the grow box located in the lower right hand corner of the
strip, pull out the strip to the size you want it to be.

If you want to resize the buttons on a strip without adding new columns or rows, hold down
the option key while resizing the window. This will only work if the icon style you have chosen
can be resized. See also “Icon Style” under the “Strip Settings” section.

USING STRIPS

This section shows you all of DragStrip’s functions. You can place various types of items on a
strip, including applications, documents, folders, volumes, and data. Depending upon the item
placed on the strip, many different functions are available to you.

APPLICATIONS

Click once on an application item to launch that application. If you drag one or more
documents from the Desktop (or from a strip) and drop it onto an application item on a strip,
the application will launch, attempting to open the documents you selected. For example, if
you have a word processor alias on one strip, and your memo template file is on another strip,
just drag your memo template alias to the word processor button. The application will then
launch the application and open your document.

Hold down the Command key on your keyboard and click once on the item to reveal the item



in its Finder window. Click-and-hold on an application to produce a list of associated docu-
ments in a popup menu. These are documents that have been dropped onto that specific
application strip item before. Choosing one of the menu items opens that document in the
chosen application. You can change the number of documents DragStrip will hold for each
application in the DragStrip preferences dialog box if you are running Mac OS X and in
DragStrip Settings if you are running Mac OS 9..

Items can be deleted from the document popup menu by choosing the document from the
application document popup and holding down the Delete key while letting go of the mouse
button. This will remove the chosen document from the document menu associated with that
application. You can also use the Documents tab of the Button Settings window to remove
items from the documents list.

Disks

Volumes (such as your hard drive) work much the same as folders. See Folders for more infor-
mation.

Note: When clicking on unmounted volumes (such as removable media) or items from
unmounted volumes, you may be presented with the Finder password dialog box.

DOCUMENTS

Clicking once on a document on a strip will launch that document in its associated application.
Dragging one or more document items onto an application item opens the document(s) in the
selected application.

Holding down the Command key on your keyboard and clicking once on the item opens the
enclosing folder of the selected item in the Finder.

FOLDERS

You can click on a folder icon and hold the mouse button down to produce a list of items
enclosed in that folder in a hierarchical popup menu. Choosing one of the menu items will
activate that item (i.e., launch a selected application, open a selected document). The folder
popup menu is hierarchical up to five levels deep.

If you drag an item from the Finder over a folder listed in the hierarchical popup menu, you
can place an item in that folder.

As with documents and applications, you can hold down the Command key on your keyboard
and click once on the item to reveal the selected item in its Finder window.



URL s

You can add URL’s, which are web and ftp site addresses, email addresses, etc. to your strip. by
clicking the button DragStrip will open that URL or start an email to that addressee.

CONHAGURING DRAGSTRIP

DRAGSTRIP MENU
Many of the configurable options on strips are available directly from menus.

INSTALL

This window allows you to select the option of opening DragStrip automatically when your
Mac starts up or you log in under Mac OS X.

REMOVE

This window allows you to remove DragStrip from your start-up items.
DRAGSTRIP PREFERENCES

You can access the DragStrip Preferences/Settings dialog box from the Options menu in Mac
OS 9.X. Preferences in Mac OS X can be found under the DragStrip menu. Choose “Prefer-
ences...” to access a list of different preference categories. Choose a category by clicking on
its name in the tabbed dialog. Clicking the “Cancel” button exits Preferences without saving
your changes. Clicking the “OK” button exits Preferences and saves your changes.

Folder Men u
The Folder menu is hierarchical up to five levels deep. Items in the popup menu will appear in
the color of their Finder labels.

N . Ba DragStrip™ Settings
’ Folder MerlluT Document List |
Menu font: | Palatino ?‘

Menu font size: = 10 |'%

[[) show hidden items
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Menu Font and Size

You can change the default font and size of the popup menus here for folders and volumes. It
is a good idea to keep the font size small and pick a font that is easy to read.

Show hidden items

Your Macintosh stores certain files on your hard drive that are invisible. Files such as the
Desktop and File Sharing documents are invisible in the Finder. You can decide whether or
not you want to see these items in DragStrip’s hierarchical menu function by checking the
“Show hidden items” checkbox.

Document Lists

DragStrip stores references to each document that has been dropped on an application on a
button in a strip. These are seen as popup menus when you click on an application and hold
down the mouse button.

3@ € DragStrip™ Settings
I' Folder Menu r Document List 1
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Documents to remember:
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15
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30
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Documents to remember

You can modify the number of document references DragStrip will hold for each application by
using the “Documents to remember” popup menu. Your choices for this modification are
None, 5, 10, 15,20, 25, 30, and Unlimited.



. Add Page
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Rotate
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Add Page allows you to add a new page to the strip. It will prompt you for a name for the
page, then add it and switch to it so you can begin adding items.

ReEMOVE CURRENT PAGE
Remove Page deletes the current page and all of the items on it.
ROTATE STRIP

Selecting this menu item will rotate the strip 90 degrees counter clockwise. Selecting Rotate
Strip again will return the strip to its normal position.

CLEAN UpP

Clean Up allows you to shift the items on your strip around without having to move them
each individually. You can access these Clean Up options from the Options menu

under Clean Up. Clean Up choices are:

I) Normal, which will move all your items in a strip to be next to each other.

2) Slide items left, which will move all of your strip items to the left.

3) Slide items up, which will move all of your strip items up.

4) Alphabetically, which will sort the items by name.

ICONIZE

You can iconize a strip down to the size of the tab by clicking the zoom box in the upper right
hand corner of the strip or by choosing this menu item.

STRIP SETTINGS

There are 4 sets of modifications you can make to your strip settings - Appearance, Font,
Behavior and Hot Corners.



Appearance tab

Allows you to customize the look of your strip.

3 8 € Pauline's strip Settings

r'ﬁppeamm:!:T Font T Behavior \T Hot Corners 1

Skin: | None ?}
Icon style: “Small Icon with Name Beside | #
Button style: 'Tiled m

Page tabs edge: .Top |

Page tabs position: | Center i !

Title bar position: .Top |
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Skin - DragStrip comes with several predefined strip styles called skins. Skins are groups of
settings that are remembered and can be applied to other strips. You can apply a skin to any
strip by selecting that skin’s name from the Skin submenu.

Icon Style - DragStrip has nine different icon styles for your strips. You can only change the
width of the icon for icon styles Large lcon With Name Besides or Below, and Small Icon With
Name Besides or Below.

Button Style - If there is no skin selected then you can modify your button style.

Pag e tabs edge - Allows you to set the placement of your tabs.

Pag e tabs position - Allows you to set the justification of your tabs.

Title bar position -  Allows you to set the placement of your titlebar.

Font tab
Allows you to set the font and point size for your buttons and tabs.

($) Pauline's strip Settings

[ Appearance T'Font:Y Behavior 'T Hot Corners ]

Button font: | Lucida Grande 'y
Button font size: | 11 | $j
Tab font: | Lucida Grande 'y

Tab font size: [ 13 % l
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Beha vior tab
Allows you to configure how your strip behaves.

$) Pauline's strip Settings

[ Appearance | Font ["Behavior | Hot Corners |

] Float this window above all applications
@jump this window to front when obscured
:‘i”\utomaticalll\yr resize to show all items
@Animate window transitions

] Anchor to the right edge of the screen

[] Anchor to the bottom edge of the screen

@ Show name when cursor hovers over items
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Hoat this window abo  ve all applications -  When this checkbox is checked, the strip will
remain in front of all windows, even in other applications. This makes it possible to click on
the strip without first bringing DragStrip to front. When enabled, the strip will always cover
windows in other applications so it is best to do this with smaller strips or strips that are
placed on your monitor where it will not interfere with the content or scrollbars of other
windows.

Jump windows to front when obscured - Sometimes there are other windows in front of
a strip window when you want to drag a something onto one of the items on the strip. When
this option is on, DragStrip will make the strip jump in front of other applications when you
drag on it, then it will go back behind when you finish the drag or drag out of the window.

Automatically resize to show all itens - When you have a page with a lot of items on it,
and another page with fewer items, it will resize the strip as you switch between the page to
show all of the items on that particular page. This is also useful if you have a page like the
processes tab where the number of items increases and decreases over time. DragStrip will
resize the window to make them all fit.

Animate window transitions - Animate window transitions only works on MacOS X.
Checking this and the Auto Resize option will cause the window to slide and resize dynamical-

ly.

Anchoring a strip to the right or bottom edge of the screen - When a strip changes
size (e.g., button sizes, strip grows/shrinks) it will remain the same distance from the bottom
or right side of the screen that it did when it was originally placed.

Show name when cursor ho  vers over item - When a strip is configured to have only
icons showing, it is sometimes convenient to be able to see the name of the item that the cur-
sor is over. When this option is turned on, a small box will appear below the item that the
cursor is over showing the name of the item.



Hot Corner tab

38 € Pauline's strip Settings
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If you are in another application, you may find that you want to access a file or function on a
strip that is hidden behind other windows. You can quickly bring the DragStrip application to
the foreground by touching your cursor to one of the Hot Corners you configure in the

Strip Settings option screen. You may choose any of the four corners of your main monitor as
DragStrip Hot Spots.

PAGE SETTINGS

You can customize how each page will look by changing the appearance and page type using
this option. Navigation arrows at the bottom left of this screen allow you to move to the pre-
vious or next page to easily customize every page on your strip

Appearance tab

Allows you name the page and change both the page and text color. The page colors might not
appear if a skin is defined to have a fixed color scheme, but any changes you make will be
saved in case you change to a different skin or select no skin.

8¢ Page Settings

r'ﬁppumnﬂ;T Page Type 1

Page name: Home

Page color: IEI
Page text color: Iil
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Page Type tab
You can change pages to a special type such as Current Running Processes. A process is

something that is currently running on your Macintosh.The Processes page shows all of the
currently-active processes on your Macintosh on one strip. This is similar to the Applications
menu in the upper right hand corner of the Macintosh menu bar in classic, but more versatile.
There are several page types to choose from that are specific to the Mac OS you are running.

‘ Normal g
Current Drives and Servers

%) Favorite Locations
EVAp; Currently Running Processes
" Applications =
Documents

Page type:

Note that changing the type of a page may result in the
current items on this page being deleted and replaced with new
items based on the type of the new page
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BUTTON SETTINGS

You can change the look of the buttons that appear on your strip. This option is enabled in the
Options menu by control clicing on a button.The General tab allows you to change the name,
add comments, add a hot key and change the color of your buttons.The button colors might
not appear if a skin is defined to have a fixed color scheme, but any changes you make will be
saved in case you change to a different skin.

Hot K eys - Hot keys allow you to switch between processes and bring DragStrip to the
front.

To set your Hot Keys:
I) Shift click a button to select it.
2) In the General tab click in the Hot Key field.

3) Press the key combination and the dialog will show you what keys activate that Hot
Key(s). Press the Delete key to remove a hot key

4) Click the “OK?” button..

When using the Hot Keys to switch between processes, a window will appear and show the
processes you can switch to one at a time. Holding the keys down allows you to switch
between processes. Letting go of the keys will switch you to the process shown in the
window.

If you set function keys (for example, FI or F2), you can switch between processes without
having to hold down the keys. Hitting “Return” or “Enter” will switch you to the process



shown in the window.

Actions menu

DragStrip allows the user to perform certain actions on one or many currently selected items
on a strip. Items on the Actions menu will be dimmed if there are no selected items on the
currently active strip.

You can shift-click items on a strip to select them. You can also choose “Select All” from the
Edit menu to select items on a strip. Selected items appear as “pressed” buttons.

Open Selection
Choosing Open Selection opens or launches the selected item(s) on the active strip.
Reveal In Finder

Choosing Reveal In Finder opens the enclosing folder for the selected DragStrip item(s)
and selects them.

GetInf o
Choosing Get Info will open the Finder Info box for the selected items on the active strip.
CoNTEXTUAL MENUS

DragStrip has extensive support for contextual menus. This is often a quicker way of
changing things on your strip than using the Options menu or the strip preferences dialog.

There are contextual menus for buttons, page tabs, process items, empty buttons and more.
Hold the control button and click on a button, page tab, etc. to use the contextual menus.

Tips AND TRICKS

DragStrip has a number of time-saving features built into it. Here is where you will find infor-
mation on many of the “hidden” secrets of DragStrip!

*  Control-clicking any part of a strip brings up a contextual menu that lets you do all sorts
of things to strips, pages and the items on them.

*  The contextual menu for page tabs lets you reorder the tabs by shifting the current page
tab to the left or to the right. This is the only way you can reorder them.



Command-clicking a file item reveals that item in the Finder.

Shift-clicking a button selects it. Most operations that can be performed on a single
button, can also be performed on a selection of buttons.

Hitting option-delete will delete the item or selection without asking.

Dragging an item from a strip to the Finder trash can will delete the item from the strip,
or quit an application if you dragged it from the processes strip.

When running Mac OS 9, option clicking an item in the processes strip will hide that
application’s windows. If it is already hidden, option-clicking it will show the application’s
windows.

Selecting option-tab will switch to the next page on the frontmost strip. If the current
page is the last page, it will go to the first page. Typing option-shift-tab will go to the
previous page.

Typing the first few letters of an item’s name will select that item.

Selecting tab will show the next item in the strip alphabetically. Shift-tab goes in the
opposite direction.

The arrow keys also work for navigating around the buttons on strips.
Hitting the enter key opens the current selection.

In Mac OS X Command-Control clicking anywhere in a window lets you drag the window
around.This should work in any window in DragStrip, except for the about box.

Holding down the “Delete” key while selecting an item from the popup document list
menu will delete that item from the document list for that application.

Clicking and holding the mouse down on an item in the Processes page pops up the same
document list for that application as you get in a ‘regular’ strip.

Enabling “Show name when cursor hovers over item” pops up a little window over items
when the cursor sits there for a little while. This is a great way of finding out which folder
you are over since folders often look alike.

Tool tips work when you are dragging too.
When you drag over a folder, if you hold the mouse still for a little bit, the folder will pop

up and you can enter into the hierarchical popup menu. Dropping a file on an application
launches that application, dropping the item in other places will copy it to the appropriate



folder.

You can rearrange the items on your strip easily by choosing one of the four “Clean Up”
options from under the Options menu.

You can make DragStrip always start up when you start up your Macintosh by selecting
“Install...” from the Mac OS 9 File menu or the DragStrip menu on Mac OS X.

You can drag on to an iconized strip and it will expand to accept the drag. When you
finish your drag, it will iconize again.

If you click an iconized strip, it will zoom to full size until you switch out of DragStrip, then
it will iconize again.
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